SZECHENY!I ISTVAN ALKALMAZOTT MECHANIKA
EGYETEM TANSZEK

Végeselem médszer 1. gyakorlat
sikbeli racsos tarté
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Adott:
Anyag: E=2-10°MPa_
v=0,3,
Terhelés: F =F,=20kN
F, =40 kN

Rudatmeéré: d =30 mm

Racsos szerkezet:
a rudak kapcsolédasi pontjaiban (a csomoépontokban) csuklék vannak és ebbdl
kovetkezben: a rudakban csak ruder6 lép fel, a ruderd értéke allando.

Mechanikai allapotok:
Elmozdulasmez6: G(&)=w(¢)e;
Igénybevétel: F; =Ng., My =0
e . . N |
Feszlltségeloszlas a keresztmetszet mentén: o, = y =All.

Terhelés: minden erét egy terhelési esetben kell figyelembe venni.
Végeselem modell: huzott-nyomott, linearis radelem.
Végeselem felosztas: rudanként egy végeselemet kell figyelembe venni.



Meghatarozandé:
» A tart6 alakvaltozasa, a rudak k6zépvonalainak elmozdulasai.
» Tamasztoerok.
» A rudakban ébredé ruder6k.

Szemléltetés:
> A szerkezet deformacié utani alakjanak kirajzoltatasa.
» A csomoponti elmozdulasok értékeinek kiiratasa.
> A legnagyobb elmozdulas helyének megkeresése és elmozdulas értékének
kiiratasa.
Az elmozdulasok szemléltetése a deformalatlan alakon vektorokkal.
Ruderék nagysaganak meghatarozasa.
Maximalis ruderé meghatarozasa.
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Az dsszes ruder6 Kiiratasa.



Inditsuk el az Abaqus CAE programot. Adjuk meg a munkakonyvtarat a File » Set
Work Directory... paranccsal. A megjelené ablakban a New work directory ala
irjuk/masoljuk be a munkakonyvtarunk helyét, vagy valasszuk ki a A select... ikonnal.
Ezutan OK-zuk le az ablakot.

Eile Model Viewport View

MNew Model Database [
Open... Ctrl+0
Metwork QDB Connector k
Close QDB...

Set Work Directory... Mote: In file selection dialog boxes, you can
click the work directory icon te jump Pl

Save Ctrl+5 to the current work directory.

save As.. Cancel

Compress MDB...

== Set Work Directory

|

Current work directory:

Ghgames\SIMULIA\temp

MNew work directory:

F\Google Drive\01_education\05_VEM\Abac
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JNl MODULE | PART geometria megrajzolasa

A program megnyitasa utan alapértelmezésként a Part Modulban vagyunk. Ez a Modul
szolgal a geometria létrehozasara. Ehhez az alabbi lépéseket kdvessik:

1. Az eszkoztarbdl kattintsunk a Create Part ikonra. Az ennek hatasara megjelend Create

Part ablakban az alabbi beallitasokat végezzuk el:
A Name utan irjuk be az alkatrészunk nevét, legyen racsos tarto.

A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 2D Planar geometriat

szeretnénk rajzolni.

A Type alatt hagyjuk az alapértelmezett kijelolést a Deformable el6tt, mivel
alakvaltozasra képes geometriat szeretnénk.
A Base Feature alatt valasszuk a Wire-t, mivel a rudakat vonalakkal fogjuk

definialni.

Az Approximate size-ot, tehat a modellink méretét itt is bedllithatnank, de erre
majd késébb visszatérink a segédracs beallitasanal, most hagyjuk az

alapértelmezett 200-on.
A fenti beallitdsok elvégzése utan kattintsunk lent a Continue... gombra.

- Part

Module:

a5 Create Part Lé]

MName: | ricsos tartd
Modeling Space
3D @ 2D Planar Asxisymmetric

Type Options
@ Deformable
Discrete rigid

Nene available
Analytical rigid

Base Feature
Shell
@ W |re§

Point

Approximate size: | 200

Caﬂpnua... Cancel

Al.2




2. A Continue... gombra kattintas utan azt tapasztaljuk, hogy a Part modul eszkoztara
megvaltozott, a rajzolast segité parancsok jelentek meg. Azt is megfigyelhetjik, hogy a
program a rajzolashoz az XY sikot ajanlja fel, és ebben a sikban automatikusan elhelyez
egy rajzolast segitdé kék segedracsot (Grid-et). A geometria megrajzolasa elétt —
kulondsen egyszeribb geometrianal — célszerli ezen segédracs meéreteit a rajzolandd
geometria méreteinek megfeleléen beallitani, igy egyszerlien meg tudjuk rajzolni a
geometriat és meguszhatjuk annak beméretezését is. A segédracs beallitasahoz
kattintsunk az eszkdztar Sketcher Options ikonjara. Az ekkor megjelend Sketcher
Options parbeszédablaknak a General filének a Grid mezéjében végezzik el az alabbi
beallitasokat:

¢ A munkaterilet mérete legyen 80 méter, ehhez a Sheet size soraban az Auto
eldl vegyiik ki a pipat, és irjunk be 80-at. igy az XY sik 1. térnegyedében egy
optimalis 40 m x 40 m nagysagu rész fog rendelkezéslinkre allni a geometria
megrajzolasahoz.

e A rovidebb, vizszintes rudak 5 méteresek, mig a fliggbleges rudak ennek
kétszeresei, 10 méteresek. Ennek megfeleléen a racstavolsagot vegyik 5 m-re.
Ehhez a Grid spacing soraban vegytk ki a pipat az Auto elél és irjunk be 5-6t.

e A geometria megrajzolasahoz elég felhasznalni a racspontokat, tovabbi belsé
segédpontokra nincs szukségunk, ezért a Minor intervals-t allitsuk egyre.

A fenti beallitasok elvégzése utan kattintsunk lent az OK gombra.

Module |5 Part I 4 Sketcher Options LE-J
+ &
i General | Dimensions | Constraints | Image |
O T Selection
) f:) /| Snap to grid
[t | Preselect geometry
< Grid
2l
s Sheet size: |80 Auto
A
g Ei Grid spacing: | 5 Auto
I 9{3 Minor intervals: | 15
LA (Snap spacing: 5.00)
O fix) Show gridlines: |¥| Major V] Minor (dynamic)
ace Align grid: | Qrigin...| |Angle...| |Reset
L
“ | Show construction geometry
(=la Max coplanar entities to project: | 300
“:%E Max level for sketch undo: |10
Sketcher
Options
ig | Apply | | Defaults| | Cancel

3. A geometria megrajzolasahoz valasszuk az eszkéztarbdl a Create Lines: Connected
parancsot. Ezutdan a segédracs segitségével rajzoljuk meg a racsos tartét. A rudakat
barmilyen sorrendben megrajzolhatjuk, és az egymas utan sorban kdvetkez8 rudakat
nem kell kilon vonalanként megrajzolni, tehat a fenti és lenti 6 db 5 m-es rudat 1-1 30
m-es vonallal rajzolhatjuk meg. A rudak megrajzolasanak egy lehetséges sorrendje:

e Rajzoljuk meg a kuls6 rudakat, tehat rajzoljunk egy 30x10 méteres (6x2 Grid
egyseéq) téglalapot.



o Az origéba visszatérés utan ujra kattintsunk az origéra és rajzoljuk meg a
baloldalon Iévé belsd rudakat.

o A 6. belsé rud utan (X,Y: 15,0) nyomjuk meg a kdzépsd egérgombot, majd
kattintsunk az (X,Y: 15,10) pontra és folytassuk a tarté rajzolasat a jobb oldali
belsé rudakkal

e Ha végeztink a geometria megrajzolasaval nyomjuk meg az Esc billentyt.

Ahhoz, hogy a vazlatbdl vonalakbdl allé alkatrész legyen a lenti beviteli mezében
kattintsunk a Sketch the section for the wire melletti Done gombra (vagy nyomjuk meg a
k6zéps6 egérgombot) Ennek hatasara elkészil a Part-unk, és visszaall a Part Modul
alap eszkdztara.

Module: |- Part :
s ﬂ&
@Z L Create Lines:

Connected A3'2

o A3.3

A3.4

; Sketch the section for the wire DDTE

A3.1 A3.5

1]

=3 MODULE | PROPERTY tulajdonsagok megadasa

Vélasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzdket, illetve rad
esetén a keresztmetszeti jellemz8ket. Ehhez az alabbi 3 Iépésen kell végmenni:

1. Anyag definidlasa: Els6é lépésként egy anyagot kell definialnunk. Ehhez a Property
modul eszkoztarabdl kattintsunk a Create Material ikonra. A megjelené Edit Material
ablakban végezzik el a kdvetkez6 beallitasokat:

o Nevezzik el az anyagot: a Name: utan irjuk be, hogy acél
e A linearisan rugalmas anyagjellemz6k megadasahoz a Material Behaviors
mezében adjuk ki a Mechanical » Elasticity » Elastic parancsot
o Az ekkor megjelend Elastic mez8ben az alabbi beallitasokat végezziik el:
oA Type mellett hagyjuk az alapértelmezett Isotropicot (az
anyagtulajdonsagok iranyfuggetlenek)




o A lenti Data tablazatban a Young’s Modulus ala irjuk be a rugalmassagi
tényez6t, azaz 2e11 (Pa) —t, a Poisson’s Ratio ala pedig a Poisson
tényez6t, azaz 0.3-at.

Module: |5 Property

Material Behaviers

General | Mechanicsl  Thermal  Electrical/Magnetic  Qther

Elasticity
Plasticity Hyperelastic
Damage for Ductile Metals Hyperfoam

Damage for Traction Separation Laws Low Density Foam

Damage for Fiber-Reinforced Composites Hypoclastic

vvvoyov[)

Damage for Elastomers Porous Elastic

Deformation Plasticity

Viscoelastic

Material Behaviors

Elastic

Type: | Isotropic

Number of field variables:

B

[T] Use temperature-dependent data

o=

Moduli time scale (for viscoelasticity): |Long-term

General  Mechanical Thermal  Electrical/Magnetic  Other

B

p =

4 Edit Material | 3 Edit Material o]
Name: |acd Narme: | acél
Description ’ Description: p

pansion
Brittle Cracking [ No tension
ﬁ 3 — Eos Data
e Viscosity Young's Poisson’s
Super Elasticity Modulus Ratio
(1 1 am
I
=W-1=}
:r'- [_T‘g_}
S L

2. Keresztmetszet definialasa: A Property Modul eszkdztarabdl kattintsunk a Create

Section ikonra. Az ekkor megjelené Create Section ablakban az alabbi beallitasokat

végezzik el:

e Nevezzik el

a keresztmetszetet:

keresztmetszet.

e A Category alatt valasszuk ki a Beam —t (rad)

o A Type alatt valasszuk a Truss —t (huzott-nyomott rud)
Ezutan kattintsunk a Continue... gombra. Az ekkor megjelend Edit Section ablakban
a Material mellett megjelent az el6zd pontban definialt acél (tdbbféle anyag esetén itt
valaszthatnank ki a kivant anyagot) A Cross-section area mellé irjuk be a
keresztmetszet mértét, azaz 706.86e-6 (m”2) —t. Ezutan kattintsunk az OK gombra.

A Name:

utan

irjuk be,

hogy Kkor

Module: || Property + ( a5 Create Section @\ I 4} Nt Sentinn @\
Z E Name: | kér kersztmetszet Marne: kor kersttmetszet
Category — Type
i o= Type: T
jba ) Selid Beam e
:T;* ;:er:taizﬂ () Shell Material: | acél E| =
M= ® Ecam Cross-sectional area: | 706.86e-6
&3 nZny ) Other
L S, Temperature variation: Constant through thickness
&0 [Cogue] [ Cance o)
B2.1 B2.2 B2.3
3. Keresztmetszet rudakhoz rendelése: A 2. pontban a kersztmetszethez mar
hozzarendeltlk az anyagot, igy most mar csak az el6z8§ pontban definialt

keresztmetszetet kell hozzarendelni a rudakhoz. Ehhez kattintsunk a Property modul
eszkoztarabdl az Assign Section ikonra. Ezutan jeldljik ki az egész racsos tartot, majd




a lenti beviteli mez6ben kattintsunk a Done gombra. Ekkor megjelenik az Edit Section
Assignement ablak, ahol kivalaszthatijuk a keresztmetszetet. Mivel csak egy
keresztmetszetet definialtunk, hagyjuk a Section melletti kér kersztmetszetet és csk OK-
zuk le az ablakot.

Module: |5 Property .
oi S 3 = [ & Edit Section Assignment e |
£ |leew |
=5 Region
ZE == = Region: Set-1
:T: j L. Section
o W=
: E}“- ] Section: | kr kersztmetszet H &
= Assign B32 e Note: List contains only sections
-] Secti = applicable to the selected regions.
ection A
B <t Type  Truss
3 ‘ Material: acél
& = ‘ Cocd =
-
I
B3.1 B3.3 [5¢] select the regions to be assigned a section ( [7] Create set: | FZE] ) B3.4

el MODULE | ASSEMBLY osszeallitas

Ennek a lépésnek tdbb alkatrészbdl allé szerkezetek esetében van igazan jelentésége, mivel
itt tudjuk létrehozni az 6sszeallitast. Jelenleg csak egy alkatrészink van, ennek ellenére nem
hagyhatd ki a 1épés, készitenink kell egy egy alkatrészbdl all6 dsszeallitast. Ehhez
kattintsunk az Assembly modul Create Instance ikonjara, majd a megjelend ablakot OK-zuk
le.

5 Create Instance [&J
&
Module: |5 Assermnbly :
Create instances from:
ALY @ Parts Models
ama
a} amn Parts
=| Create
A Instance
= ==
ie @
b Instance Type

.1. ”_. @ Dependent (mesh on part)
;Ia —“—! Independent (mesh on instance)

ry

\?/ Note: To change a Dependent instance's
— mesh, you must edit its part's mesh,
4= Auto-offset from other instances

b, om
= mn. EJ‘Q Apply Cancel

)] MODULE | STEP lépések megadasa

A Step modulban a végrehajtandd vizsgalat(ok) tipusat (pl. statikus, dinamikus, hétani...),
azok reészleteit és sorrendjét tudjuk beallitani. Jelenleg 1 db statikus lépést kell definialnunk.
Ehhez kattintsunk a Step modul Create Step ikonjara. a megjelend Create Step ablakban
nevezzik el a Iépést: a Name: utan irjuk be, hogy terhelés. A Procedure type-ot hagyjuk az
alapértelmezett General — Static, General — on. Ezutan kattintsunk a Continue... gombra,
majd a megjelend Edit Setup ablakban hagyjunk mindent alapértelmezésen, csak OK-zuk le.



2 Create Step @

Mame: |terhelés 57 Edit Step ===
Neme: terhelés
Module: |5 Step : Insertnew St ep it ey Type: Statc, General
E Description:
.-’I?E max Time period: |1
A ® Off (Thi setting controls the inclusion of nonlinear effects
=7 Create Nigeom: " “of large displacements and affects subsequent steps.)
1] G
"0 P Automatic stabilization: | None H
o = |
Procedure type: | General [] Include adiabatic heating effects
=1 : —
'i%‘ g Dynamic, Temp-disp, Explicit o
Geostatic
:'-Jnﬂ‘ i!) Heat transfer
Mass diffusion
et ,L Soils £
+ Fl a4 "
,ﬂ- + Static, General
H
._.j‘ u,, Static, Riks -
< i s
Ca G
Contique... Cancel

] MODULE | LOAD peremfeltételek megadasa

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogasokat) és
dinamikai peremfeltételeket (terheléseket). Jelen feladatban 2 megfogast (csuklé és gorgd)
és 3 terhelést (3 koncentralt erd) kell definialni.

1. megfogasok definidlasa: (az alabbi Iépéseket kétszer kell végcsinaini)

Kattintsunk a Load modul Create Boundary Condition ikonjara.

A megjelend Create Boundary Condition ablakban nevezzik el a megfogast
csuklé-nak, illetve gorg6-nek, a Category-t hagyjuk az alapértelmezett
Mechanical-on, a Types for Selected Step alatt pedig valasszuk ki a
Displacement/Rotation-t. Ezutan kattintsunk a Continue... gombra.

Jeldljuk ki a rajzon a csuklo, illetve goérgé helyét (kijeldléskor egy kis piros pont
jelenik meg a kijelolés helyén).

A lenti beviteli mez6ben kattintsunk a Done-re

Az ekkor megjelené Edit Boundary Condition ablakban akadalyozzuk meg csuklé
esetén az X és Y iranyu, mig gorgd esetén az Y iranyu elmozdulast. Ehhez csuklo
esetén az U1 és U2 elbtti négyzeteket, gorgd esetén az U2 elbtti négyzetet
pipaljuk be. Ekkor az elmozdulashoz automatikusan bekertilnek a 0 értékek. OK-
zuk le az ablakot.



csuklé megadasa

gbrgbé megadasa

Module: | Load :

R
ENE

Medule: | Load :
L
MER

Name: | csukla

Procedure: Static, General
Category

@ Mechanical

©) Electrical/Magnetic
(@ Other

Confinue...

Step: | terhelés [

Types for Selected Step

Symmetry/Antisymmetry/Encastre

Displacement/Rotation

Velocity/Angular velocity
Connector displacement
Connector velocity

Cancel

Create Create
Boundary Boundary
[ Condition [ Condition
El.1 E1.6
( 4= Create Boundary Condition @\ ( 5 Create Boundary Condition @

Mame: | gorgd
Step: | terhelés E|
Procedure: Static, General
Category Types for Selected Step

® Mechanical Symmetry/Antisymmetry/Encastre

© Electrical/Magnetic | ([IEEEUEEI T

() Other Velocity/Angular velocity
Connector displacement
Connector velocity

E1.2

E1.7

E1.3

E1.8

Select regions for the boundary condition { [7] Create set:

) WE

Select regions for the boundary condition ({ (V] Create set: m

oy

El4

E1.9

4% Edit Boundary Condition @

Name:  csukla

Step:  terhelés
Region: Set-1

Lo

Type:  Displacement/Rotation

CS¥S: (Global) [3 L

Distribution: | Uniform E| fix)
ul: 0

U2 0

[ UR3: radians
Amplitude: | (Ramp) E| F\:

Note: The displacement value will be
maintained in subsequent steps.

(Static, General)

Cancel

4% Edit Boundary Conditicn @

Name: gorgd

Type:  Displacement/Rotation
Step:  terhelés (Static, General)
Region: Set-2

CSYS: (Globaly [3 L

Distribution: | Uniform B fix)
[ u1:

uz: 0

[ URz: radians
Amplitude: | (Ramp) B r\J

Note: The displacement value will be
maintained in subsequent steps.

El{ Cancel

E15

E1.10

2. terhelések definialasa: (az alabbi lépéseket 3-szor kell végcsinalni F1, F2 és F3 -ra)

e Kattintsunk a Load modul Create Load ikonjara.
¢ A megjelen6 Create Load ablakban nevezziik el az erét F1-nek, F2-nek, illetve
F3-nak. A Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for
Selected Step alatt pedig valasszuk ki a Concentrated force-t. Ezutan kattintsunk
a Continue... gombra.




Jeldljuk ki a rajzon az F1, F2 illetve F3 helyét. (kijeloléskor egy kis piros pont

jelenik meg a kijelolés helyén).

A lenti beviteli mez6ben kattintsunk a Done-re
Az ekkor megjelen6 Edit Load ablakban adjuk meg az er6komponensek
nagysagat N-ban: (F1 er6 esetén CF1=20000, F2 esetén CF2=-20000, F3 esetén

CF2=-40000)

F1 er6 megadasa

F2 er6 megadasa

F3 er6 megadasa

Madule: | Load :
e

E; Create

Load

(e
I 2

Module: |5 Load :

Module: |5 Load :
E&

E; Create

Load

= =
T E2

E2.1

E2.6

E2.11

a5 Create Load &J

a5 Create Load

4 Create Load

Shell edge load
Surface traction

() Electrical/Magnetic Pipe pressure
Body force
) Other Line load
Gravity
Bolt load

Confinue... Cancel

Mame: | F1
Stept | terhelés E|
Procedure: Static, General
Category Types for Selected Step
Mement
Pressure

Mame: | F2
Step: | terhelés E|
Procedure: Static, General
Category Types for Selected Step
Otchol [ -
Moement
Pressure

Shell edge load 3
) Surface traction
© Electrical/Magnetic | | pjpe pressure
Body force
© Other Line load
Gravity
Bolt load 2

Cancel

ConElinue‘..

Name: F3
Step:  terhelés H
Procedure: Static, General
Category Types for Selected Step
Moment
Pressure

m

Shell edge load
Surface traction

() Electrical/Magnetic Pipe pressure
Body force
() Other Line load
Gravity
Bolt load -

E2.2

E2.7

E2.12

N

E23

E2.8

E2.13

T .
Select points for the load ( [¥] Create set: |F528 ) Select points for the load ( [¥] Create set: | FEH] ) Select points for the load ( [7] Create set ) [Er‘f

E2.4 E2.9 E2.14

2 Edit Load - & Eit Load [ 2 Edit Load =

Mame: F1
Type:  Concentrated force
Step: terhelés (Static, General)

Region: 5et-3

CSYS: (Global) [3 L

Distribution: | Uniform E| fix)
CFlL: 20000

CF2:

Amplitude: | (Ramp) E| PU

[ Follow nodal rotation

Note: Force will be applied per node.

Co) (ol

Mame: F2

Type:  Concentrated force
Step: terhelés (Static, General)
Region: Set-4

CsYSs: (Global) [p L

Distribution: | Unifarm E| fix)
CF1:

CF2: -20000

Amplitude: | (Ramp) E| r\l

[ Follow nodal rotation

Note: Force will be applied per node.

g

Mame: F3

Type:  Concentrated force
Step: terhelés (Static, General)
Region: Set-5

Csvs: (Globaly [y L

Distribution: | Uniform E| fix)
CFl:

CF2: -40000

Amplitude: | (Ramp) EI P\J

[] Follow nodal rotation

Note: Force will be applied per node.

Co)  (ona)

E2.5

E2.10

E2.15

10



I3 VODULE | MESH [T

A végeselem halot a Mesh modulban tudjuk elkésziteni. Legel6szor fent az Object-et allitsuk
at Part-ra, aminek hatasara a Part mellett megjelenik a racsos tarto felirat.

Module: |: Mesh

[ [l ‘

m  m

EI Model: | Model-1 EI Object: () Assembly T‘\Part | rdcsos tartd :

g’

Ezutan a halézast az alabbi lépésekben végezziik el:

1.

2.

Elemtipus megadasa:

e Kattintsunk a Mesh modul Assign Element Type ikonjara.

e JeldljUk ki a telies racsos tartét, mivel minden rudhoz ugyanolyan elemtipust
szeretnénk rendelni.

e A lenti beviteli mez&ben kattintsunk a Done gombra

e A megjelend Element Type ablakban a Family-t allitsuk at alapértelmezésrél

Truss-ra, azaz huzott-nyomott rddelemre (T2D2 tipus), majd OK-zuk le az
ablakot.

2 Element Type
Element Library Family
@ Standard () Explicit | Piezoelectric
Pipe
s soscar i3 tony Geometric Order Thermal Electric
Module: |5 Mesh : @ Linear Quadratic
[‘“. l Line
-, LA,
Hybrid formulation
-
@E‘ @E Element Controls
9,?] ﬁq F1. Scaling factors: Linear bulk viscosity: |1
N 5
@iq @/
Assign
Elerment Type 1-
=) |
ﬂ. === T202: A 2-node linear 2-D truss.
Note: To select an element shape for meshing,
select "Mesh-> Controls' from the main menu
[ o]
F1.1 F1. K| Select the regions te be assigned element types Fl1.4

Elemméret megadasa:

Mivel a racsos tartd huzott-nyomott rudakbdl all, célszer( 1 rudat 1 végeselemnek venni.
Ehhez az alabbi Iépéseket végezziik el:

e Kattitnsunk a Mesh modul Seed Edges ikonjara.

o Jeldljuk ki az egész racsos tartot.

e A lenti beviteli mez86ben kattintsunk a Done gombra.

e A megjelend Local Seeds ablakban a Basic fulon a Method-ot allitsuk By

number-re, a Sizing Controls mez&ben pedig a Number of elements-et 1-re.
Ezutan OK-zuk le az ablakot.

11




& |ocal Seeds
[ Basic | Constraints |
L Methed Bias
Module: | Mesh “) By size @ None ) Single ) Double
— - @ By number
r- i, [Q Sizing Controls
%;E‘ a Seed Edges F2.2 Number of elements: 1%
Y]
[y Set Creation
[T] Create set with name: | Edge Seeds-1
g [ Apply | [ Defauts ] [ cancel |
F2 1 F2 3 [%] setect the regions to be assigned local sceds | individually B [E] Use single-bias picking F2 4

3. Végeselem halo elkészitése:
A végeselem halé elkészitéséhez kattintsunk a Mesh modul eszkdztaraban a Mesh Part
ikonra, majd a lenti beviteli mezében az OK to mesh the part? mellett a Yes gombra.

f [
i =

i

Module: | Mesh : Model:l

ﬁ Mesh F'arﬂ

, @ OK to mesh the part? @

F3.1

F3.2

Haldtulajdonsagok lekérdezése (opcionalis)

A csomépontok és végeselemek szamanak ellendrzéséhez a Tools » Query...
Parancsot hasznalhatjuk. A felugr6 Query ablakban a General Queries mez&ben
kattintsunk a Mesh-re, majd a lenti beviteli mezét a Query entire part-on hagyva a Done

gombra. Ekkor a lenti parbeszédablakban megjelenik a csomopont szam (Total number
of nodes) és az elemszam (Total number of elements). Jelen feladat 14 csomoépontot és

25 végeselemet tartalmaz.

—-—
et

B [ Display detailed report W‘k

E4.3

— — 5 Query & EJ Query entire part
daptivity Feature | Tools Plug-ins Help &7 General Queries
1 o Ty 3 | | e
2z Set » Distance

r Angle

Surface L4 Feature
e ;Mesh Partition... Obj Shell element normals =

Datom Beam element tangents

Mesh stack orientation

Virtual Topology » 53]

E Total numbker of nodes: 14
Total number of elements: 25
25 linear line slements of type T2D2

Display Group  »

Element E!
Mesh gaps/intersecti

E41 UE42

E4.4

el MODULE | JOB feladat megoldasa

A feladatot a Job modulba atlépve tudjuk lefuttatni. Az ehhez szikséges Iépések:

1.

Feladat definialasa:

e A Job modul eszkdztarabdl kattintsunk a Create Job ikonra
e A megjelend Create Job ablakban kattintsunk a Continue... gombra

e A megjelend Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le
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2= Edit Job -

Name: Job-1

- -\
Medel: Model-1
— (S
5 Create Job

Analysis product: Abaqus/Standard
Name: | Job-1 Description:
Submission | General | Memory | Parallelization | Precision
Source: | Model EI
Job Type

(©) Restart
Run Mode

@ Background ©) Queue:

Submit Time

@ Immediately

[ Contiw [ Cancel : . l,-g,
5
Gl.1 Gl.2 G1.3

2. Feladat lefuttatésa:
e A Job modul eszkdztarabdl kattintsunk a Job Manager ikonra
o A megjelend Job manager ablakban alapbdl ki van valasztva az el6bb definialt 1
db feladat (Job-1). Kattintsunk a Submit gombra.
o Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen
lefutott. Az eredmények megjelenitéséhez kattintsunk a Results gombra.

Module: |2 Job H "2 1ot Manager | (2 o0 Manager =)
[

= | Name Model Type Status Name Model Type Status

Ls
@ﬂ i Job

Manager
i ==
iib g e e e e e o)

H EYeN=NRYIS{S/\RVINi[6]\M credmények megjelenitése

A Results gombra kattintva automatikusan a Visualisation modulba kerulink. Fent
valasszuk ki az U-t vagy az S-t annak megfeleléen, hogy az elmozdulast, vagy a feszlltséget
szeretnénk megjeleniteni. El6szor valasszuk az U-t.

[ e e o s8]

rauts [+] 5+ : B pimary [+ s i F[E]

E

4

RF
5

e

A Plot Contours on Deformed Shape ikonra kattintva a deformalt alakot lathatjuk.
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g — S ———————] s 3
EEtlimea nwmiEALM 2@ HTTE 0 @ e K ) - Fa 5 5| vestsion defss [ @ || b pimay v ] Magntuse FE]

MDdu\r‘:‘dls_hxmmn H Modek [[] 1/ Google Drive/01 _education/05_VEM Abaqus_workaracsostartoT/Job-L.odb j o

14770e03
+3.1808-03 -
+1590.03 ——
+0.0008 400 s

I B&

3 g
Fi |42 | = B |6

K@ —~— |
E- 1= |
KY- |

< — 1

Bal felul lathato szinskala alapjan a maximalis elmozdulas 19 mm kéral van.

N -

Az Odb Display Options-ban megjelenithetjik a keresztmetszetet tetszéleges mértékben
felnagyitva. Ezt kiprébalas utan kapcsoljuk ki, mert a tovabbiakban zavaré lehet.
I

it Plot  Animate Rgport:

R e @ 20U
Module [£]visualization [+ ' ’
BLE

M QOdb Display

Genwrol ity Dusplay | Constiamts  Sweep/Extrude | Meevoe:Puttern

A Common Plot Options-ban a Basic fulon beallithatjuk a deformacioé felnagyitasanak
mértékét, a Labels flldén bekapcsolhatjuk a csomépontok és elemek sorszamanak
megjelenitését.

4 Common Plot Opfions _ =)

-
_ Basc | Color&Style | Labels | N <
ender Style es

ult Plot Animate R|| -
. © Filleg @ Shaded
& @IE‘ Il LI Deformation Scale Factor cature edges
(©) Auto-compute (160.503) - ree edges
Module: |%| Visualizatid||| © Nonuniform ©/NoeI9=
Value: | 200 I v
I 123 @
L3
U,
Common Options

B B, H

© Hidden

o) 1.908e-02
i tikess L 014
& commenpocOptns |y 9 . 10 o 25
8 [ Color &Ste | Labels | Normals | Other 10 24
abel and Symbols gl - V13
~PE—— O 2
|
8 22
) Shownedeymbols  Colr ) 21 “ 1
symbot| ® [ sze[tage o] 20 | 13
ColrCode | 19 18 | 14
= I 7o 26 1P
Setfont] Color (EM) &\/g ‘\ ] % 2
9] [ho) [(ovks] [Coei] ~7. 7 2
e T | .3
= o6 ‘ 3
s i 5 4 4
Y
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A Contour Options—ban a Limits fulén bekapcsolhatjuk a max/min helyek megjelenitését.

g

VIDOUIE! |5] Visuaiization

¢ e
T

=
=
w

@
5
@

Elagj C‘nntnur Opti

Ez)ﬂ::

=Y

O e
et

P L e
%
I3
~

Fent a feszlltséget valasztva a Contour Plot Options Basic filén a Contour Type-ot
allitsuk Quilt-re

§ .
2 Cantour Plot Options . [
Basic | Color & Style | Limits | Other

Contour Type

© Line ©) Banded @ Quilt () Iosurface

[ Show tick marks for line elements.

Contour Intervals

12
1@ Discrete =]
Interval type: | Uniform — [1]
B‘-‘iﬁ Primary B u E Magnitude B
11itan
Contour Method
cF M| i
E @ Texture-mapped () Tessellated
RF v

5
L5
oK [ Apply | [ Defaults | [ Cancel |

Az adatok tablazatszeri lekéréséhez hasznaljuk a Report »Field Output... parancsot.

e A Position-t Unique Nodal-ra allitva jeloljik ki az RF (reakcioerd) és az U
(elmozdulas) alatti négyzeteket. Ezzel a reakciderék, illetve az elmozdulasok
nagysagat, illetve x és y 6sszetevdit tudjuk lekérni csomdpontonként.

e Kattintsunk az Apply gombra

e Szedjuk ki az 6sszes pipat

o A Position mellett valasszuk a Centroid-ot

o Az S (feszilltség) alatt valasszuk a Mises-t. Ezzel a HMH szerinti redukalt
feszlltséget tudjuk lekérni elemenként.

o Kattintsunk ismét az Apply gombra.

Animate | Report Options  Tools  Plug-i

IIEA Y
Field Output...
= Visualizi Free Body Cut.. :/Google Driv
1
|
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4 Report Field Output

ﬂr; Report Field Cutput

4 Report Field Output

Step/Frame
Step: 1, terhelés

Frame: 1 [Step/Frams

Step/Frame
Step: 1, terhelés

|| Frame: 1 [Step/Fram

Step/Frame
Step: 1, terhelés

Variable | Setup Variable | Setup Variable | Setup
Output Variables Output Veriables Output Variables
[ postion [uniguenicas bostion urigeetiodt ] bosition
| [l i
||| Click checkboxes or edit the identifiers shown next to Edit below. | |Il||  Click checkboxes or edit the identifiers shown nextto Edit below. ||| Click checkboxes or edit the identifiers shown next to Edit below.
1l I |
| CF: Point loads || > FIcr pointicas: || | ¥ [1E Strein components
Il E: Strain components | | » 1€ Strain components || | = @ Stress components
1l | 3
RF: Reaction force 'l | % [F1RR Reaction force Mises
Megnitude [ Max. In-Plane Principal |
RFL Max. In-Plane Principal (Abs)
iy 7] Min. In-Plane Principal
Max, Principal
S: Stress components X
» S: Stress components. 7] Max. Principal (Abs)
U: Spatial displacement ; Spatial displacement Min. rincipal
Magnitude Tresea
ul Pressure
w2 N Third Invariant
si1 |
it | Edit:| S Mises
Section paint: © All © Sele Section point: @ All © Select [Sefting: Section peint: /|

A munkakoényvtarban a fentiek hatasara egy abéqus.prt nevl fajl keletkezett, mely a lekért

adatokat tartalmazza.

Fajl Saekesmés Formitum  Nezet Sigo

Node Label ¥ .Magnitude RE.RFL RE.RF2 u.magnitude

(X eLoc 1 #Loc 1 #Loc 1

o. 0. 7.392215-03

0. 43.33336403  7.78089€-03

o. 0. 1i.50268-03

0. 0. 18.30886-03

o 0. 19.08056-03

0. 0. 13.6889%-03

0. 0. 7.31723€-03

-20.6403  16.66675403 %

0. 0. 9.55089-03

0. 0. 0

0. o
o o.

0. 15.24886-03
0. 4.2a5736-03  4.245736-03
wminimun o. 20,5403 0. 0. 20.00008-33
AT Node 1 s 1 ] 8
waxinum 43.33336403 0. 43.33336403  19.0805€-03  9.550896-03
At node 2 1 2 H 3
Total  69.3675€+03 20,6403 60.00006+03  157.9046-03  73.75296-03

Field output Report, written wed sep 27
source 1

Qpe: 3:/Google befve/01_educaton/03_VEM/Abaqus.wor ks/racsostar to?/ Job-1. odb
step: terhelés

Increment 1: step Time =
Loc 1 : Centroidal values from source 1

output sorted by column “lement Label”,

1.000

Field Output reported at element centroid for part: ricsos tart6-1

Element Label

s.Mises
oc 1

68, 5399+

51.8726E+
7 20.0834E+

28.2941E+1

434
828288

61, 3040k+
30, 6520E+

°88¢

- 156-03
430313323
-18.67976-03

5
-16.66676-33

-122.108¢-03
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